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Elektoonilisel kujul olevad kasutusjuhendid antakse välja "Nokia kasutusjuhendite
sätted ja tingimused, 7. juuni 1998" alusel (“Nokia User’s Guides Terms and
Conditions, 7th June, 1998”.)
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OHU VÄLTIMISEKS Lugege läbi järgnevad näpunäited. Reeglitest 
üleastumine võib põhjustada ohtlikke olukordi ning võib olla 
seadusevastane. Põhjalikum teave on ära toodud eraldiolevas 
kasutusjuhendis.

OHUTU LIIKLEMINE KÕIGEPEALT Ärge kasutage kommunikaatorit 
autojuhtimise ajal, esmalt parkige auto.

HÄIRED Kõiki traadita telefone võivad mõjutada häired, mis põhjustavad 
tõrkeid telefoni töös

HAIGLAS LÜLITAGE TELEFON VÄLJA Järgige kõiki eeskirju ja reegleid. 
Meditsiinilise aparatuuri läheduses lülitage telefon välja.

LENNUKIS LÜLITAGE TELEFON VÄLJA Traadita telefonid võivad 
põhjustada häireid. Nende kasutamine lennukis on seadusega keelatud.

TANKIMISE AJAL LÜLITAGE TELEFON VÄLJA Ärge telefoni tanklas 
kasutage. Ärge kasutage ka kütuse ega kemikaalide lähedal.

LÕHKAMISTÖÖDE PIIRKONNAS LÜLITAGE TELEFON VÄLJA Ärge 
kasutage telefoni piirkonnas, kus pannakse toime lõhkamisi. Järgige 
piiranguid ja pidage kinni kõigist määrustest ja reeglitest.

KASUTAGE MÕISTUSPÄRASELT Kasutage vaid normaalasendis. Ärge 
katsuge põhjuseta sisselülitatud telefoni antenni.

PROFESSIONAALNE TEENINDUS Varustuse paigalduse ning remondi 
peab teostama kvalifitseeritud spetsialist.

LISAVARUSTUS JA AKUD Kasutage ainult ettenähtud lisavarustust ja 
akusid. Ärge ühendage omavahel tooteid, mis ei ühildu.
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TELEFONIGA HELISTAMINE Sulgege seadme kaas ja kontrollige, et 
telefon oleks sisse lülitatud ja võrgu poolt teenindatav. Sisestage 
suunanumber ja telefoninumber ning vajutage . Kõne lõpetamiseks 
vajutage . Kõne vastuvõtmiseks vajutage .

HÄDAABI VÄLJAKUTSE Sulgege seadme kaas. Kontrollige, et telefon 
oleks sisse lülitatud ja võrgu poolt teenindatav. Displei puhastamiseks 
hoidke mõne sekundi jooksul all  klahvi. Sisestage hädaabi 
telefoninumber ja vajutage . Teatage oma asukoht. Ärge kõnet enne 
katkestage, kui Teile on selleks luba antud.

TEHKE VARUKOOPIAID Ärge unustage tegemast varukoopiaid vajalikest 
andmetest.

TEISTE SEADMETEGA ÜHENDAMINE Kui ühendate telefoni teiste 
seadmetega, lugege läbi nende seadmete kasutusjuhendites toodud 
ohutusnõuded. Ärge ühendage tooteid, mis omavahel ei ühildu.

INFRAPUNANE KIIR Ärge suunake infrapunast kiirt inimestele silma ning 
veenduge, et see ei häiriks teisi infrapunase kiirega töötavaid seadmeid. 
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Vaadake, kas müügipakendis on olemas kõik loetletud asjad:
• Nokia 9210 Communicator
• Mälukaart
• Käesolev kasutusjuhend, Settings checklist, lühi-ja lisavarustuse juhend ning 

Add-on applications guide
• Võimsusaku BLL-3
• Laadija ACP-9
• RS232 DLR-2L kaabel
• Arvutitarkvaraga CD-ROM
• Kleebised, millel on kommunikaatori seerianumber ja turvakood

Telefoni kasutamine
Näpunäide: Interaktiivse 

abi kasutamiseks avage kaas 
ja vajutage  (help) 
klahvile.

Selleks et Nokia 9210 Communicatoriga helistada ja kõnesid vastu võtta:
• peab telefon olema sisse lülitatud,
• telefonis peab olema kehtiv SIM-kaart ja 
• Te peate olema mobiilsidevõrgu teeninduspiirkonnas.

Mõned võrgud võimaldavad rahvusvahelisele hädaabinumbrile 112 helistada ka 
ilma SIM-kaardita. Lisateave võrguoperaatorilt.
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Märkus: Hoidke väikesed SIM-kaardid eemal väikelaste käeulatusest. 

1 Sulgege seadme kaas ja veenduge, et telefon oleks välja lülitatud. Kui telefon 
on sisse lülitatud, vajutage .

2 Kui kommunikaatoriga on ühendatud aku, eemaldage see. Vajutage aku peal 
olevale lukustusnupule ning võtke aku süvendist välja. Vaadake joonist 1.

Joonis 1

3 Paigaldage SIM-kaart SIM-kaardi süvendisse: Jälgige, et SIM-kaardi kullavärvi 
kontaktid jääksid allapoole ja kaardi äralõigatud nurk paremale poole. Vaadake 
joonist 2.
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Joonis 2

SIM-kaart on hoidikusse paigaldatud õigesti siis, kui kaardi äralõigatud nurk 
jääb nähtavale, nagu on näidatud joonisel 3.

Joonis 3
äralõigatud nurk on nähtaval
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a 4 Olles veendunud, et SIM-kaardi paigaldus on korrektne, paigaldage tagasi ka 
telefoni aku. Kui aku laetus on madal või kui aku on tühi, on soovitav ühendada 
kommunikaator laadijaga ning laadida enne ettevalmistavate protseduuride 
jätkamist kommunikaatori aku. 

5 Avage kommunikaatori kaas. Kommunikaator viib läbi enesetestimise, mille 
vältel kuvatakse displeil tervitusteksti.

6 Kui kommunikaator on enesetestimise lõpetanud ning mitmekeelse 
klaviatuurikonfiguratsiooni valik on kasutatav, palutakse Teil valida, millist 
klahvipaigutust soovite kasutada. Konfiguratsiooni kinnitamiseks vajutage OK.
Kui klaviatuuri konfiguratsiooni valik ei ole kasutatav, ilmuvad displeile maade 
nimetused.

Näpunäide: Kodulinna, 
ajavööndit ning kuupäeva ja 
kellaaja esitusviisi saate 
hiljem muuta 
kommunikaatori 
rakendustest Clock (Kell) ja 
Control panel (juhtpaneel).

7 Liikuge nooleklahviga oma kodulinna nimetusele ja vajutage OK. Displeile 
ilmub kellaaeg ja kuupäev.
Linna nimetuse leidmiseks otsingu teel, sisestage akna alumises servas olevale 
otsinguväljale otsitav väärtus.

8 Kui vaja, muutke kellaaeg ja kuupäev ning vajutage OK.

Näpunäide: Hiljem võite 
rakenduses Contacts 
(kontaktandmed) lisada 
visiitkaardile ka pildi.

9 Järgmisena võite muuta visiitkaardil olevaid andmeid. Vajutage OK.
Kui kommunikaatoris on kehtiv SIM-kaart, võivad andmed või osa andmeid 
visiitkaardile salvestuda ka SIM-kaardilt. 

10 Displeile ilmub teade, mis kinnitab, et kommunikaatori käivitamine on edukalt 
lõpule jõudnud. Vajutage OK.
Märkus: Akut ei ole võimalik süvendisse mahutada, kui SIM-kaart on valesti 

paigaldatud. Ärge suruge akut jõuga süvendisse! Kontrollige, kas SIM-
kaart on paigaldatud eespool antud juhiste kohaselt. Kui SIM-kaart on 
valesti paigaldatud, võtke kaart hoidikust välja ning paigaldage uuesti.
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Näpunäide: Aku laetuse 
taset näitab 
kommunikaatori või telefoni 
displeil olev aku indikaator 

.

1 Ühendage laadija juhe kommunikaatori põhja all olevasse pesasse, vaadake 
joonist 4.

Joonis 4

2 Ühendage laadija vastava võrgupingega seinakontakti. Laadimise ajal rullub 
telefoni displeil aku laetuse pügalindikaator.

3 Pügalindikaator lõpetab rullumise ja näitab nelja pügalat, kui aku on täielikult 
laetud. Ühendage laadija kommunikaatorist lahti.
Märkus: Laadimise ajal võib kommunikaatorit kasutada tavapärasel moel.
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Näpunäide: Kui vahetate 

mõne eelmise Nokia 
Communicatori mudeli 
Nokia 9210 Communicatori 
vastu välja, vaadake 
kasutusjuhendi peatükki 
"General information" 
(Üldine teave).

Joonis 5

Kommunikaatori liidese põhifunktsioonid ja displei tähised on näidatud joonisel 5. 
Displei sisselülitamiseks tuleb Teil vaid avada kommunikaatori kaas. Displeile ilmub 
rakendus, mis oli viimasena aktiveeritud, kui Te kommunikaatorit kasutasite.

Kui Te kaane sulgete, salvestab kommunikaatori liides kogu info ning lülitab oma 
displei välja.

Märkus: Andmeid eraldi salvestada ei ole vaja. Kui vajutate Close, avate teise 
rakenduse või sulgete seadme kaane, salvestab Nokia 9210 
Communicator automaatselt kõik andmed.

Käsuklahvid

Nooleklahvid
Menüü klahv

Klaviatuur
Abiteksti klahv

Rakendusklahvid

Displei
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Klaviatuuri ülaservas olevad klahvid avavad vastava rakenduse. Kasutusel on 
järgmised rakendused: Desk, Telephone, Messaging, Internet, Contacts, 
Calendar, Office ja Extras.

Näpunäide: Menüüriba 
kõige vasakpoolsemast 
servast saab valida hetkel 
avatud rakendusi.

Rakenduste vahetamiseks vajutage vastavale rakendusklahvile. Seda võib teha 
isegi kõne ajal. Teil ei ole vaja ühtegi rakendust sulgeda, enne kui teise rakenduse 
avate. Passiivsed rakendused jäävad tagaplaanil avatuks, kuni Te need uuesti 
aktiveerite.

Displei elemendid

Joonis 6

See element on 
valitud

Parempoolne aken. 
Markeerimiseks vajutage 
Tab-klahvile.

Vasakpoolne aken on 
markeeritud

Elemendi üksikasjad Võimalikud rakendatavad 
käsud
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kasutusjuhendis on öeldud, 
et “vajutage Open”, 
tähendab see, et Teil tuleb 
vajutada käsu Open kõrval 
olevale käsuklahvile.

Displei peamised elemendid on näidatud joonisel 6. Käsud on alati seotud nelja 
käsuklahviga. Käesolevas juhendis on käsud esitatud rasvases kirjas ning displeil 
ja menüüreal olevad tekstid kaldkirjas.

Kerimisriba näitab, et hetkel displeil olevad elemendid ei ole ainukesed, mida Teil 
on võimalik vaadata. Sirvimiseks kasutage klaviatuuri alumises parempoolses 
nurgas olevaid nooleklahve.

Kui displei alumisel real on otsingu väli, on Teil võimalik teatud elementide 
otsimiseks klaviatuurilt otsingu väljale teksti sisestada.

Kui displeil on mitu akent, on valitud aken alati markeeritud.

Valitud aknas liikumiseks ning elementide valimiseks kasutage nooleklahve.

Menüükäskude avamiseks vajutage klahvile Menu.

Häälestus
Selleks et ühendust saada Interneti, WAP-teenuste ja oma elektronpostkastiga, 
tuleb Teil kommunikaator vastavalt konfigureerida. 

Märkus: Konfigureerimist hõlbustab kommunikaatori müügipakendisse lisatud 
häälestuse kontroll-loend (Settings checklist). Kontroll-loendis on ära 
toodud kõik vajalikud andmed, kust neid leida ning kuhu need 
kommunikaatoris sisestada. Ja veel, kirjutage andmed ka kontroll-
loendisse, et Teil hiljem kogu vajalik info käepärast oleks ning kasutage 
loendit ka oma teenusepakkujaga suhtlemisel, kui Teil on vaja saada 
teenusepakkujalt informatsiooni kommunikaatori konfigureerimiseks.

1 Vajutage klaviatuuril rakendusklahvile Extras.



©2001 Nokia Mobile Phones. All rights reserved.

9

Ku
id

as
 a

lu
st

ad
a2 Valige nooleklahvi abil ikoon Internet startup ja vajutage Open. Ilmub kolm 

ikooni: Internet access, WAP access ja Mail account.
3 Valige Internet access ja vajutage Open. Avaneb dialoog.

Näpunäide: Põhjalikum 
teave kasutusjuhendi 
peatükis "Extras" (Lisad).

Näpunäide: Abiteabe 
saamiseks selle kohta, 
millised andmed käesolevas 
ja ka järgnevates 
dialoogides tuleb sisestada, 
vajutage interaktiivse abi 
avamiseks klaviatuuril  
klahvile, uurige ka 
kasutusjuhendit.

Joonis 7

Näpunäide: Lehtede 
sirvimiseks vajutage klahvile 
Menu.

4 Sisestage andmed ja vajutage Advanced settings. Avaneb dialoog neljal lehel.

Joonis 8

Sisestage igale lehele vajalikud andmed. 
Lehel Other vajutage Address options. Avaneb dialoog.
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Joonis 9

Siin määratlege IP ja DNS aadressid.
Vajutage Done, et pöörduda tagasi displei pildile, kus oli kolm ikooni.

Näpunäide: Põhjalikum 
teave kasutusjuhendi 
peatükis "Internet".

5 Valige WAP access ja vajutage Open. Avaneb dialoog.

Joonis 10

Sisestage igale lehele vajalikud andmed ja pöörduge tagasi ekraanile, millel on 
kolm ikooni, vajutades Done.

Näpunäide: Põhjalikum 
teave kasutusjuhendi 
peatükis "Messaging" 
(Sõnumid).

6 Valige Mail account ja vajutage Open. Avaneb dialoog neljal lehel.
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Joonis 11

Sisestage igale lehele vajalikud andmed ja pöörduge tagasi ekraanile, millel on 
kolm ikooni, vajutades Close.

Ühendamine PC-arvutiga
Kasutades kommunikaatori müügikomplekti lisatud CD-l olevat programmi PC 
Suite for Nokia 9210 Communicator on Teil võimalik ühendada oma 
kommunikaator ühilduva PC-arvuti või sülearvutiga. CD sisaldab ka juhendit “PC 
Suite Guide”, see asub sektoris Using Nokia 9210 Communicator.

PC Suite for Nokia 9210 Communicator toetab operatsioonisüsteeme Windows 95/
98, 2000 ja NT. Nimetatud programm integreerib kommunikaatori ja arvuti 
failisüsteemid ning võimaldab ajakuluta ja lihtsal moel teisaldada, kopeerida, 
ümbernimetada ja kustutada kommunikaatoris ja arvutis olevaid faile ja katalooge.

PC Suite võimaldab sünkroniseerida kommunikaatori ja arvuti rakendustesse 
salvestatud andmeid, näiteks kontaktandmeid või elektronkirju ning teha arvutisse 
andmete varukoopiaid. Te saate valida, et sünkroniseerimine ja varundamine 
toimuksid automaatselt etteantud ajavahemike tagant või ühenduse loomisel.
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a Programmi PC Suite võib kasutada ka ajal, mil kommunikaator ei ole arvutiga 
ühendatud (autonoomselt). Kui te seadmed järgmine kord omavahel ühendate, 
lisatakse arvutis tehtud muudatused ka kommunikaatoris olevatesse andmetesse 
ja vastupidi.

TÄHELEPANU: Hoiduge viirustest. Installeerige kommunikaatorisse ainult 
kindlatest allikatest pärinevat ning viiruste eest kaitstud 
tarkvara. Vaadake kasutusjuhendi peatükki "Certificate 
Management".

Kommunikaatori ühendamine PC-arvutiga
1 Kui kasutate kaabelühendust, ühendage RS-232 kaabli suurem pistik arvuti 

järjestikporti (COM) ja väiksem pistik kommunikaatori põhja all olevasse pessa. 
2 Kui Teie infrapuna- või jadaport ei ole COM1, vaid mõni teine port, tehke 

topeltklõps Windows’i tegumiribal olevale PC Suite ühenduse ikoonile ning 
valige kasutatav port.

3 Avage kommunikaator.
4 Kui kasutate infrapunaühendust, veenduge, et kommunikaatori ja arvuti 

infrapunaliidesed asetseksid vastakuti. Kommunikaatori infrapunaliidese 
aktiveerimiseks vajutage Chr +  (infrapuna-sümboliga tähistatud klahv). 
Täiendavat teavet kommunikaatori infrapunaliidese aktiveerimise kohta leiate 
kasutusjuhendist.

5 Käivitage PC Suite tarkvaraprogramm arvutis. 
PC Suite programm peaks nüüd kommunikaatoriga ise ühenduse looma.
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Rakenduste gruppi Desk kasutatakse mitmesuguste linkide - sidelülid teiste 
rakendustele või tarkvaraprogrammide vahel - haldamiseks ja linkide avamiseks. 
Uute linkide loomine toimub vastavates rakendustes.

Lingi loomine
1 Avage vastavast rakendusest lingitav element. 
2 Vajutage klahvile Menu ja valige seejärel Add to Desk.

Märkme kirjutamine
1 Vajutage Write note. Avaneb lihtne tekstiredaktor.
2 Kirjutage märge.
3 Dokumendi salvestamiseks vajutage Close. Märge ilmub rakenduse Desk 

põhiaknasse.

Telefon (Telephone)
Rakendust Telefon kasutatakse helistamiseks ja kõnede vastuvõtmiseks ning 
telefoni seadete muutmiseks. Telefoni rakenduse aktiveerimiseks avage 
kommunikaatori kaas ja vajutage klaviatuuril rakendusklahvile Tel. Enamikke 
rakenduse Telephone toiminguid saate sooritada ka kommunikaatori esipaneelilt.

Helistamiseks 
• peab telefon olema sisse lülitatud,
• kommunikaatoris peab olema kehtiv SIM-kaart ning 
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a • Te peate olema mobiilsidevõrgu teeninduspiirkonnas.

Helistamine
Helistamiseks on kaks moodust:
• Valige kataloogist Telephone kontaktkirje ja vajutage Call. Kui selle kirje juures 

on ainult üks telefoninumber, valitakse kohe see number.
Kui sellel kontaktisikul on mitu telefoninumbrit, avaneb telefoninumbrite loend, 
valige loetelust sobiv number ja vajutage Call.

• Sisestage põhiakna alumisel real olevale otsinguväljale telefoninumber ja 
vajutage Call.

Kõne vastuvõtmine
Kui Teile saabub telefonikõne, ilmub displeile sellekohane teade. Võib-olla kostab 
ka helin. Kõne vastuvõtmiseks vajutage Answer, kui Te kõnele vastata ei soovi, 
vajutage Reject.

Profiil Flight (lennuk)
Profiil Flight välistab telefoni tahtmatu sisselülitamise lennusõidu ajal. Profiili 
Flight valimiseks:
1 Vajutage rakenduse Telephone põhiaknas klahvile Menu, liikuge menüüribal 

profiilide ikoonile , seejärel markeerige valik Flight.
2 Vajutage Select.

Lennuprofiilis on Teil võimalik kasutada kommunikaatori neid funktsioone, kus ei 
ole vaja ühendust võtta mobiilsidevõrguga. Näiteks saate Te lugeda eelnevalt 
võrgust allalaetud elektronkirju, kirjutada elektronkirju, märkmeid, lühisõnumeid, 
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lennuprofiil välja, vajutades telefoni rakenduses Exit profile. Nüüd võite  
klahvile vajutades telefoni sisse lülitada, et telefon saaks kirjutatud lühisõnumid, 
faksid ja elektronkirjad automaatselt ära saata.

Kui kommunikaator on lennuprofiilis, tuleb hädaabi kõne sooritamiseks kasutada 
telefoni (sulgege kommunikaatori kaas):
1 Vajutage . Telefoni displeile ilmub teade Flight profile is active..
2 Ajal, mil tekst on displeil (umbes viie sekundi jooksul), võite valida 

kommunikaatorisse programmeeritud hädaabinumbri, näiteks numbri 112.
3 Vajutage .

TÄHELEPANU! Ärge kunagi lennukis telefoni kasutage. Kui lennuki personal on 
andnud Teile loa kommunikaatori liidese kasutamiseks, PEATE Te 
aktiveerima lennuprofiili. Lennuprofiil võimaldab üksnes 
kommunikaatori liidese kasutamist , telefoni kasutamine on 
tõkestatud. Pidage meeles, et kõik siderakendused töötavad ainult 
koos telefoni liidesega.

Sõnumid (Messaging)
Sõnumite rakendus koosneb kolmest funktsioonist: Fax, Mail ja SMS 
(lühisõnumiteenus). Sõnumirakenduse avamiseks vajutage klaviatuuril 
rakendusklahvile Messaging.

Fakside, elektronkirjade ja lühisõnumite saatmiseks ja vastuvõtmiseks
• peab telefon olema sisse lülitatud,
• Teie poolt kasutatav võrk peab toetama faksi- ja andmesidekõnesid ning SMS-i,
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a • Teie SIM-kaardil peab olema aktiveeritud faksi-, andmeside- ja 
lühisõnumiteenus (SMS),

• Teil peab olema nn. Internet Access Point (IAP) ehk internetikonto, mille saate 
internetiteenuse pakkujalt ning Te peate sisestama õiged Interneti ja 
elektronposti seaded

• SMS rakenduse seadetesse peab salvestatud olema Teie sõnumikeskuse 
number.

Lisainformatsiooni saamiseks pöörduge oma teenusepakkuja poole.

Märkus: Nokia 9210 Communicator meilisüsteem ühildub 
internetistandarditega SMTP, IMAP4 ja POP3.

Fakside, elektronkirjade ja lühisõnumite 
kirjutamine ja saatmine
Fakside, elektronkirjade ja lühisõnumite kirjutamine toimub vastavates 
redaktorites, millede avamiseks on kolm teed: 
• Kasutage teksti kirjutamiseks ja redigeerimiseks suvalist kommunikaatori 

rakendust, mis seda võimaldab. Saatmiseks vajutage klahvile Menu, valige File 
> Send ning leidke alammenüüst vajalik saatmisfunktsioon.

• Vajutage rakenduse Messaging põhiaknas vastavale käsuklahvile: Write fax, 
Write mail või Write short message.

• Valige rakenduse Messaging põhiaknas Write > New message…. Seejärel valige 
sõnumi formaat.

Adressaatide valimine
Märkus: Faksi puhul saab olla ainult üks adressaat.
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1 Valige vastavas tekstiredaktoris funktsioon Recipient. Avaneb kontaktkirjete 
loend.

2 Leidke vasakpoolsest väljast kontaktisik või -isikud ja vajutage Select.
3 Vajutage Done.

Teine võimalus: kirjutage faksi, elektronkirja või lühisõnumi päisesse adressaadi 
nimi ja kontrollige, kas selline kirje on andmebaasis olemas.

Fakside ja lühisõnumite vastuvõtmine ja lugemine
Kui faksiteenus on kasutatav, telefon on sisse lülitatud ja asub mobiilsidevõrgu 
teeninduspiirkonnas, toimub faksi vastuvõtt automaatselt. Lühisõnumid võetakse 
vastu automaatselt, kui telefon on sisse lülitatud.

Vastuvõetud faksi- või lühisõnumi lugemiseks on kaks moodust:
• Kui märkate displeil vastavat teadet või kuulete saabunud sõnumi helisignaali, 

vajutage Open. Helisignaal kostab ainult teatud tingimustel.
• Avage sõnumite rakendus. Valige funktsioonist Inbox saabunud sõnum ja 

vajutage Open. Faksid ja lühisõnumid avanevad vastavas loetelus.

Elektronkirjade allalaadimine ja lugemine
Teile adresseeritud elektronkirjad ei saabu mitte kohe Teie kommunikaatorisse, 
vaid serverarvutis asuvasse postkasti. Selleks, et elektronkirju lugeda tuleb Teil 
kõigepealt ühendust võtta serverarvuti postkastiga ja valida sealt kiri, mis seejärel 
kommunikaatorisse laetakse. Serverarvutiga luuakse ühendus andmekõne 
vahendusel.



©2001 Nokia Mobile Phones. All rights reserved. 

18
Ku

id
as

 a
lu

st
ad

a Ühenduse võtmine serverarvuti postkastiga
1 Valige sõnumite rakenduse põhiakna vasakpoolsest väljast serverarvuti postkast 

(remote mailbox).
2 Valige parempoolne väli ja vajutage Retrieve mail. 
3 Kui ühendus serverarvuti postkastiga on loodud, vajutage klahvile Menu ja 

valige Retrieve > ja siis, vastavalt sellele, millised sõnumid Teid huvitavad, New, 
Selected või All.

4 Kui kõik kirjad, mis vastasid Teie valikule, on kommunikaatorisse laetud, 
vajutage Go offline.

5 Valige kiri, mida soovite lugeda ja vajutage Open.

Internet
Ühenduse saamine Internetiga eeldab, et 
• Teie poolt kasutatav mobiilsidevõrk andmeedastust toetab,
• andmesideteenus on Teie SIM-kaardi jaoks aktiveeritud,
• olete internetiteenuse pakkujalt saanud internetikonto ehk nn. Internet Access 

Point'i (IAP) ning
• olete sisestanud õiged Interneti seaded. Vaadake kasutusjuhendis antud 

juhiseid. Fikseerige oma toimingud kommunikaatori müügikomplekti lisatud 
kontroll-loendis (Settings Checklist).

Internetiühenduse konfigureerimise kohta saate informatsiooni oma 
internetiteenuse pakkujalt. Järgige täpselt antud juhiseid.

Märkus: Internetiühenduse loomiseks peab telefon olema sisse lülitatud ja 
asuma võrgu teeninduspiirkonnas. Eelnevalt lõpetage kõik 
pooleliolevad telefoni- ja andmesidekõned.
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1 Vajutage kommunikaatori klaviatuuril rakendusklahvile Internet.
2 Valige sobiv rakendus, näiteks WWW, ja vajutage Open. Kui rakenduse avamine 

eeldab Internetiühenduse olemasolu, avaneb dialoogiboks, milles näidatakse 
kasutusel oleva Internetiühenduse konto nimetust Connection name ning 
sissehelistamise telefoninumbrit Phone number. 

3 Ühenduse loomiseks vajutage OK.
4 Rakenduse sulgemiseks vajutage Done.
5 Internetiühenduse katkestamiseks vajutage suvalises Interneti rakenduses olles 

kommunikaatori klaviatuuril olevale rakendusklahvile Internet, seejärel 
vajutage Disconnect. Ühendus katkeb koheselt.

World Wide Web (WWW) brauser
WWW kujutab endast hüpertekstil põhinevat süsteemi, mida kasutatakse 
Internetist info leidmiseks. Veebilehtede sirvimine:

Näide: URL võib olla näiteks 
selline: www.nokia.com.

Näpunäide: Mõnedel 
veebilehtedel palutakse Teil 
enne lehekülje avamist 
sisestada oma kasutajanimi 
ja parool. Kasutajanimi ja 
parool salvestatakse ning 
järgmine kord ei ole Teil vaja 
neid enam sisestada.

1 Vajutage klahvile Menu ja valige File > Open > Web page…
2 Sisestage aadressväljale lehekülje URL address või valige järjehoidjate loetelust 

vajalik järjehoidja ja vajutage Go to. Teistele veebilehtedele saate liikuda ka 
oma WWW brauseri avaleheküljelt.

3 Kui lehekülg on võrgust alla laetud ja avatud, vajutage linkide ja hotspot'ide 
avamiseks Tab-klahvile. Tagasi liikumiseks vajutage Shift+Tab. Võite kasutada 
ka osutusseadist (Pointer tool), mis aktiveeritakse kiirklahvi kombinatsiooniga 
Ctrl + Q. Osutusseadise kohta leiate täiendavat teavet kasutusjuhendist.
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a 4 Mõne teise lehekülje või saidi avamiseks valige hüperlink või hotspot ja 
vajutage Go to.

WAP
WAP-rakendus on hüpertekstil põhinev süsteem internetiteenuste, näiteks uudiste, 
ilmateadete, lennukite väljumisaegade, sõnastike jm. kasutamiseks. Teenuse 
sihtgrupiks on mobiiltelefonide kasutajad.

WAP-teenuste kasutamiseks: 
• peate viibima andmeedastust võimaldava mobiilsidevõrgu teeninduspiirkonnas,
• andmesideteenus peab Teie SIM-kaardi jaoks aktiveeritud olema,
• Teil peab olema WAP-internetikonto, mille saate WAP-teenuse pakkujalt ning
• peate olema sisestanud õiged WAP-seaded. Vaadake kasutusjuhendis antud 

juhiseid.

WAP-teenuste leidmine
WAP-lehekülje avamiseks:
1 Vajutage Klahvile Menu ja valige File > Open page. Avaneb dialoog. Sisestage 

URL aadress, näiteks: mobile.club.nokia.com.
2 Sirvimiseks ning hüperlinkide ja hotspot'ide valimiseks kasutage nooleklahve.

Märkus: Piiratud kasutusega serveritele ligipääsemiseks tuleb sisestada õige 
kasutajanimi ja parool. Sel juhul palutakse Teil oma kasutajanimi ja 
parool sisestada enne teenusega ühenduse võtmist.
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Kontaktkirjete rakenduse avamiseks vajutage klaviatuuril rakendusklahvile 
Contacts. Rakendust Contacts kasutatakse kontaktandmete, näiteks 
telefoninumbrite ja aadresside salvestamiseks, muutmiseks ja haldamiseks. 
Rakenduse Contacts kirjeid nimetatakse kontaktkaartideks. Kontaktandmeid võib 
sünkroniseerida ka ühilduvas arvutis olevate andmetega.

Kontaktkirjete peamine andmebaas on kommunikaatori mälus. Kontaktandmeid 
võib salvestada ka eraldiseisvate andmebaasidena mälukaardile.

Kontaktkaardi loomine
1 Vajutage rakenduse Contacts põhiaknas New card.
2 Sisestage avanenud kontaktkaardi väljadele kõik vajalikud andmed.
3 Kontaktkaardi salvestamiseks vajutage Done.

Helistamine
Rakenduse Contacts põhiaknas on kaks välja, vasakpoolne ja parempoolne väli. 
Vajutage Tab-klahvile, et liikuda parempoolsele väljale. Markeerige kontaktkirje 
telefoninumber ja vajutage Call.
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Rakendusest kalender saate vaadata oma sündmusi, kohtumisi, täht- ja sünnipäevi 
ning samuti toiminguid, mida Teil on vaja teha. Kõikidele kalendri kirjetele saab 
lisada meeldetuletussignaali. Kalendri rakenduse avamiseks vajutage 
kommunikaatori klaviatuuril rakendusklahvile Calendar.

Kui ühendate oma kommunikaatori ühilduva PC-arvutiga, võite Microsoft 
Windows ja Lotus programmides sünkroniseerida oma kalendermärkmeid ja tööde 
ning toimingute loetelusid.

Uue kalendrikirje loomine
Üks kalendrikirje loomise võimalustest on järgmine:
1 Vajutage klahvile Menu ja valige File > New entry. Valige kirje tüüp: 

Appointment…, Event…, Anniversary… või Task….
2 Sisestage dialoogi väljadele vajalikud andmed.

Kuu ülevaade
Kuu lõikes antud ülevaade on kalendri põhiaknaks. Kui olete sisestanud sellesse 
kuusse kalendrikirjeid, näete nende loetelu displei parempoolses servas. 
Kalendrikirje muutmiseks:
1 Vajutage klahvile Enter või Edit day, et markeerida parempoolne väli.
2 Valige kalendrikirje ja vajutage Edit. Avaneb kirjega seotud üksikasjade 

blankett.
3 Muutke kirjega seotud informatsiooni.
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Nädala ülevaates esitatakse valitud nädala ajakava. Nädala ülevaate avamiseks 
vajutage Change view ja valige Week.

Päeva ülevaade
Päeva ülevaade esitab valitud päevale salvestatud kirjed. Päeva ülevaate avamiseks 
vajutage Change view ja valige Day. 

Toimingute ülevaade
Toimingute ülevaates näidatakse korraga ühte toimingute loetelu. Toimingute 
ülevaates on võimalik oma toiminguid reastada ja korrastada. Samas võite määrata 
oma töödele tähtajad ja prioriteedi. Tööde ja toimingute loetelusid võib olla mitu, 
üks näiteks ametialaste tööde ja teine isiklike toimingute tarbeks. 

Muud ülevaated
Kommunikaatoris on teisigi ajaplaneerijaid, näiteks aastaplaani koostamiseks või 
tähtpäevade planeerimiseks.

Office
Office koosneb järgmistest funktsioonidest: Word, Sheet, Presentation viewer ja 
File manager, mis kõik ühilduvad Microsoft Windows-iga.
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Kui avate rakenduse Word, avaneb kohe ka uus dokument ning Te võite kohe 
kirjutama hakata.

Dokumendi salvestamiseks vajutage Close. Avaneb dialoog. Nüüd on Teil vaja 
dokumendile nimi anda ning valida, millisesse kataloogi see salvestatakse.

Sheet
Rakenduses Sheet on Teil võimalik töötada nn. töövihikutega (workbook) ning 
samas vormingus oma andmed ka salvestada. Iga töövihik koosneb vähemalt ühest 
arvutustabelist. Töövihik võib sisaldada ka diagrammtabeleid (chartsheets). 
Diagrammtabel on arvutustabeli (spreadsheet) vormingus olev dokument, milles on 
arvutustabeli andmete baasil koostatud diagramm.

Töövihiku ja arvutustabelite koostamine
Näpunäide: 

Arvutustabeli lisamiseks 
rakendusse Desk vajutage 
klahvile Menu ja valige File > 
Add to Desk.

Uue töövihiku loomiseks vajutage klahvile Menu ja valige File > New workbook.

Töövihiku salvestamiseks vajutage arvutustabeli aknas klahvile Menu ja valige File 
> Save.

Uue arvustustabeli loomiseks töövihikus vajutage klahvile Menu ja valige Insert > 
New worksheet.

Andmete sisestamiseks valige nooleklahviga lahter ja trükkige sellesse lahtrisse 
vajalikud andmed.

Sisestatud andmete kinnitamiseks vajutage Enter, OK või liikuge nooleklahviga 
järgmisele lahtrile. Tühistamiseks vajutage Esc või Cancel.
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vajutageFunction. Kategooriad on järgmised: All, Financial, Date and time, 
Mathematical, Statistical, Lookup, Text, Logical ja Information. Igal kategoorial on 
omad funktsioonid, mida saab vaadata nimetuse Function name kõrval olevast 
loetelust.

Diagrammtabeli loomine
Diagramme on seitset liiki: Column, Stacked column, Line, Pie, Bar, Stacked bar ja X/Y 
scatter.
1 Selekteerige teatud arvutustabeli piirkond. Diagrammi loomisel kasutatakse 

valitud piirkonna lahtritesse sisestatud andmeid.
2 Vajutage klahvile Menu ja valige Insert > New chart. Avaneb dialoog.
3 Määratlege järgmised andmed: Chart name, Chart type, 3-D, Background colour ja 

Axis colour.
4 Uue diagrammtabeli loomiseks vajutage Close, loobumiseks vajutage Cancel.

Presentation viewer
Presentatsiooni avamiseks vajutage rakenduse Presentation põhiaknas Open. 
Rakenduse sulgemiseks vajutage Close.

Näpunäide: Parema 
ülevaate saamiseks 
kasutage suurendamise või 
siis vähendamise võimalust.

Kui dokument on avatud, näidatakse displeil esimest slaidi. Järgmise slaidi 
vaatamiseks vajutage Next või Enter. Eelmise slaidi vaatamiseks vajutage 
Previous. Slaidi üles-alla kerimiseks kasutage nooleklahve.

File manager
Rakendust File manager kasutatakse kataloogide sisu ja atribuutide haldamiseks.
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a Kataloogid võivad paikneda kahes juurkataloogis: kommunikaatori ja mälukaardi 
omas.

Kommunikaatori juurkataloogis on kataloog \Documents\, milles on algselt neli 
kataloogi: \Documents\Downloaded\, \Documents\Photo gallery\, 
\Documents\Templates\ ja \Documents\Tones\.

Faililoend omakorda näitab vasakpoolsel väljal valitud lähteallikas või kataloogis 
olevaid faile. Faililoendi päises on näidatud hetkel valitud faili otsingutee. 
Faililoendis võite näha ka programmiikooni, faili nimetust ja viimast muutmise 
kuupäeva. Failid paiknevad tähestikulises järjekorras.

Kataloogi sisu vaatamine
1 Valige vasakpoolsest kataloogipuu raamist kataloog ja vajutage Open. 

Näidatakse selle kataloogi alamkatalooge ja faile.
2 Alamkataloogi avamiseks valige see ja vajutage Open.
3 Põhiakna taasavamiseks vajutage Done.

Faili avamine
1 Valige fail ja vajutage Open. Fail avaneb vastavas rakenduses. 
2 Põhiaknasse tagasipöördumiseks vajutage Close folder.

Uue kataloogi loomine
1 Vajutage failihalduri põhiaknas klahvile Menu ja valige File > New folder. Avaneb 

dialoog. 
2 Andke uuele kataloogile nimi.

Failide ja kataloogide otsing
1 Valige kataloog või salvestuskoht, kust otsitakse. 
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3 Sisestage väljale otsingu string. 
4 Otsingu täpsemaks piiritlemiseks vajutage Options.

Loetelus oleva elemendi muutmiseks vajutage Change. 
Kui olete lõpetanud, vajutage Close.

5 Otsingu käivitamiseks vajutage Find.
Otsingu katkestamiseks vajutage Stop.

6 Kui otsing on lõppenud, vajutage leitud kataloogi või faili avamiseks Open.
Uue otsingu käivitamiseks vajutage New find.

7 Põhiaknasse tagasipöördumiseks vajutage Close.

Lisad (Extras)
Lisarakenduste vaatamiseks vajutage klaviatuuril rakendusklahvile Extras. 
Markeerige nooleklahvi abil vajalik rakendus ja vajutage Open. 

Lisarakendusi saab installeerida ka müügikomplektis olevalt CD-ROM-lt.

Kell (Clock)
See rakendus näitab nii Teie kodulinna kui teiste linnade ja riikide kellaaega ja 
kuupäeva. Kella rakenduses on ka äratuskell.

Äratuse seadmine
Näpunäide: Kalendri 

meeldetuletussignaalide 
seadmine toimub kalendri 
rakenduses.

1 Vajutage kella põhiaknas Alarm clock. Avaneb äratuskella aken.
Kellaaja kõrval näete aktiivseid äratuse kellaaegu.

2 Uue äratuse määramiseks vajutage New alarm.
Olemasoleva äratuse muutmiseks vajutage Edit alarm.
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3 Määratlege äratuse kellaaeg - Time.
4 Määratud äratuse aktsepteerimiseks vajutage Close.

Äratussignaali väljalülitamine
Vajutage Stop või suvalisele klahvile klaviatuuril.

Äratuse ajutiseks väljalülitamiseks vajutage Snooze.

Kalkulaator (Calculator)
Kommunikaatoris on kaks erinevat kalkulaatorit: tavaline kalkulaator lihtsamate 
aritmeetikatehete jaoks ja keerulisemate funktsioonidega kalkulaator 
keerulisemate matemaatiliste arvutuste sooritamiseks.

Tehte sisestamine võib toimuda kahel moel: sümbolite sisestamise teel 
sisestusväljale või sümbolite valimise teel sümbolite loetelust. Vastuse saamiseks 
vajutage Enter või =. Arvutustehe ja tulemus on näha displei vasakpoolses servas. 
Sisestus- ja tulemusvälja ning sümbolite loetelu valimiseks vajutage Tab-klahvile 
või valige Change focus.

Juhtpaneel (Control panel)
Juhtpaneelilt saate vaadata ja muuta järgmisi seadeid: Data call barring, Date and 
time, Regional settings, Internet access, Profiles, Security, Certificate manager, Install/
Remove software, Default folder, Memory ja About product.

Loetletud funktsioonide seadete muutmine avaldab mõju kommunikaatori 
kõikidele rakendustele.
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aVastava programmi avamiseks ja muudatuste sisseviimiseks valige nooleklahviga 

rakendus ja vajutage Open.

Salvesti (Recorder)
Näpunäide: Salvestiga 

on võimalik salvestada 
helisid või kõnet ning 
kasutada neid salvestisi 
telefonihelinana. Vaadake 
kasutusjuhendit.

Salvesti võimaldab ka telefonivestluse ja kõnemälude salvestamist. Samas on Teil 
võimalik nii oma salvestusi kui muid helifaile kuulata ja muuta.

Telefon

Joonis 12

Telefon

Kuular

Eestvaade Tagantvaade

Mikrofon
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a Telefoni sisselülitamine
1 Kui seadme kaas on avatud, sulgege see.
2 Telefoni sisselülitamiseks vajutage  klahvile ja hoidke seda all. 

Kui telefon palub sisestada PIN-koodi, sisestage koos SIM-kaardiga saadud PIN-
kood ja vajutage  klahvile, mis asub täpselt displeiteksti OK all. 

TÄHELEPANU! Kui mobiiltelefonide kasutamine on keelatud, kui see võib 
tekitada häireid või ohtlikke olukordi, ärge telefoni sisse lülitage.

Indikaatorid displeil
Indikaatorid displeil informeerivad Teid telefoni toimingutest. Kui telefon on 
kasutamiseks valmis ning ütegi sümbolit displeile sisestatud ei ole, näete telefoni 
displeil järgmisi tähiseid.

VÕRGU NIMI või LOGO 

- Näitab kasutusel oleva operaatorvõrgu nimetust.

 ja sümboli kohal olevad segmendid.

- Näitavad signaali tugevust Teie praeguses asukohas. Mida rohkem segmente Te 
näete, seda tugevam on signaal.

 ja sümboli kohal olevad segmendid.

- Näitab aku laetuse taset. Mida rohkem segmente Te näete, seda suurem on aku 
laetus.
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Helistamiseks sisestage suunanumber ja telefoninumber, seejärel vajutage .

Kõne vastuvõtmiseks vajutage .

Kõne lõpetamiseks vajutage . 

Valiku klahvid
Profiilide vahetamine.

 Liikumine menüüdes, alammenüüdes ja seadevalikutes. Kui Teil 
parasjagu kõnet pooleli ei ole, võite sirvimisklahvidega sirvida mälukirjeid. Kui Teil 
on kõne pooleli, võite sirvimisklahvidega reguleerida kuulari helitugevust.

 kuni  Numbri- ja täheklahvid. Kõneposti helistamiseks hoidke all 
 klahvi.

 Kasutatakse erifunktsioonides. Kui Teil on liitumislepingu kohaselt 
kaks abonentnumbrit, võite ühelt liinilt teisele lülituda hoides all  klahvi. 

 Nende valiku klahvide funktsioon sõltub displei alumisel real olevast 
tekstist.

Märkus: Kuular ja mikrofon paiknevad seadme tagaküljel.

Forum Nokia
Nokia Wireless Data Forum kujutab endast internetiteenust, mis on esmajoones 
suunatud teistele firmadele, kes tegelevad Nokia platvormi toetavate rakenduste 
ja teenuste arendusega. Kõnealune veebileht sisaldab infot nii arendusvõimaluste 



©2001 Nokia Mobile Phones. All rights reserved. 

32
Ku

id
as

 a
lu

st
ad

a kui olemasolevate turundusprogrammide kohta ja on mõeldud peaasjalikult 
inimestele, kes tegelevad arendusprogrammide väljatöötamise ja süsteemi 
integratsiooniga teistele Nokia koostööpartneritele.

Samuti pakub Nokia Wireless Data Forum tootetuge Nokia 9210 Communicatorile 
ja teistele Nokia mobiilsideseadmetele. Nimetatud veebilehelt leiate asjakohast 
kirjandust, draivereid, lühijuhendeid, teavet seadmete ühilduvuse kohta ja palju 
muud.

Kellele pakub huvi mobiilsidevõrkudes toimiv andmeedastus, saab veebilehelt 
lugeda selles vallas kasutusel olevate erinevate teooriate kohta.

Nokia Wireless Data Forum asub aadressil http://www.forum.nokia.com

Club Nokia
Club Nokia - kui tahate oma Nokiast viimast võtta. Club Nokia liikmena on Teie 
käsutuses mitmed eksklusiivsed eelised. Mainitud eeliste hulka kuulub näiteks 
kiirteenindus, uute Nokia toodete esmatutvustus, mitmesugused eripakkumised, 
ligipääs Club Nokia veebilehele ja palju muud.

Kui Teil on küsimusi, vastab neile Nokia telefonide tõeline ekspert. Teil on lihtne 
ligipääs meie tootetuge pakkuvale nõuandetelefonile, Club Nokia Careline'le. 
Samuti on Teil lihtne ligipääs Club Nokia Instant Service'le, mis on registreeritud 
Club Nokia liikmete ööpäevaringne teeninduskeskus. Club Nokia Service Points 
teeninduskeskused on kõikjal Euroopas. 
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aKõikidele Club Nokia teenustele, tooteinfole, eripakkumistele, uudistele ja 

konkurssidele pääsete kõige lihtsamal moel ligi Club Nokia veebilehe vahendusel. 
Club Nokia toimib enamikes Euroopa riikides - hakka liiikmeks juba täna. Club 
Nokia leiate aadressilt http://www.club.nokia.com.
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Näpunäide: Saadaval on 
väga erineval otstarbel 
kasutatavaid Nokia 
originaaltarvikuid: 
kaasaegsed 
andmeedastusseadmed, 
käed-vabad süsteemis 
töötavad peakomplektid, 
kaasaskantavad või 
kohtkindlad laadijad ja 
telefonihoidikud.

Nokia originaaltarvikud kindlustavad Teie Nokia mobiiltelefoni töövõime igas 
olukorras. Nokia 9210 Communicatori lisaseadmete väljatöötamisel on silmas 
peetud erinevate inimeste väga erinevaid sidevajadusi.

Märkus: Kasutage ainult neid akusid, laadijaid ja lisavarustust, mis on telefoni 
tootja poolt heakskiidetud ja vastavad Teie kommunikaatori mudelile. 
Vastasel korral kaotavad kehtivuse kommunikaatorile seatud nõuded 
ja garantii ning võib tekkida ohtlik olukord.

Seadme toide
Võimsusaku BLL-3

Joonis 13
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Kasutustingimustest sõltuvalt annab kõnealune aku Teile 4-10 tundi kõneaega 
ning 80-230 tundi ooteaega.

Nokia 9210 Communicatori kaal koos akuga on 244 g.

Kiirlaadija ACP-9

Joonis 14

Näpunäide: Sobib 
suurepäraselt neile, kes 
palju reisivad.

Kiirlaadija ACP-9 on kerge ja vastupidav laadija, mis sobib enamasti kõikide 
võrgupingetega. Laadimise ajal toimub kommunikaatori kasutamine tavapärasel 
moel. Antud laadijaga kestab kommunikaatori laadimine umbes 180 minutit 
(sõltub aku eelnevast laetuse tasemest).

Euroopa mudel Inglise (UK) mudel
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Näpunäide: Akude 
laadimiseks on vajalik 
kiirlaadija ACP-9 olemasolu. 
PC-arvutiga ühendamiseks 
on Teil vaja RS-232 kaablit 
DLR-2L. PC-arvutiga võib 
laualaadija ühendada ka 
infrapunaliidese vahendusel.

Joonis 15

Mitmefunktsionaalse laualaadija DCH-10 abil saate mugavalt
• laadida kommunikaatoriga ühendatud akut
• ühendada kommunikaatori PC-arvutiga.

Laualaadija vasakpoolsel küljel on infrapunaliides; vaadake joonist 15. Laadijal on 
eraldi pesa kommunikaatorist eraldatud akude laadimiseks, mugav võimalus 
varuakude laadimiseks. 

Kommunikaatori aku laadimine laualaadijas
1 Pistke kiirlaadija ACP-9 laualaadijasse.
2 Asetage kommunikaator, millega on ühendatud ka aku, ühenduspesaga ots ees, 

laualaadijasse.
3 Ühendage laadija vooluvõrku.

varuaku 
laadimispesa

infrapunaliides
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1 Pistke kiirlaadija laualaadijasse.
2 Pistke varuaku, kullavärvi kontaktid eespool teise pessa. Kõigepealt suruge akut 

allapoole ja siis natuke tagasi, kuni kuulete klõpsatust.
3 Ühendage laadija vooluvõrku. Kontrollige, et laualaadija vasakul küljel põleks 

indikaatorlamp. Punane tuli näitab, et toimub laadimisprotsess. Kui aku on täis 
laetud, põleb pidevalt roheline indikaatorlamp.

4 Eemaldamiseks liigutage akut ettepoole, seejärel ülespoole ja eraldage 
laadijast.
Märkus: Kui laualaadija laeb samaaegselt ka kommunikaatori akut, katkeb 

varuaku laadimine seniks, kuni kommunikaatori aku on täielikult 
laetud.

Ühendamine PC-arvutiga
Kommunikaatori ühendamine ühilduva PC-arvutiga toimub RS-232 kaabli DLR-2L 
vahendusel järgnevalt:
1 Ühendage kaabel laualaadija taga olevasse ühenduspessa.
2 Kaabli teine ots ühendage PC-arvutiga. 
3 Asetage kommunikaator, ühenduspesa eespool, laualaadijasse.
4 Käivitage arvutis rakendus PC Suite for Nokia 9210 Communicator või siis 

faksi- või modemirakendus.

Võimalik on kasutada ka infrapunaühendust, toimige järgmiselt:
1 Kontrollige, et kommunikaatori ja PC-arvuti infrapunaliidesed on aktiveeritud
2 Asetage kommunikaator, ühenduspesa eespool, laualaadijasse.
3 Seadke laualaadija ja PC-arvuti infrapunaliidesed ühele joonele. 

Infrapunaliideste kaugus teineteisest ei tohiks ületada 30 cm.
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faksi- või modemirakendus.

Kommunikaatori ja PC-arvuti ajaplaneerijatesse sisestatud andmete 
sünkroniseerimiseks vajutage lihtsalt üks kord  klahvile. Lisainformatsiooni 
leiate müügikompletis olevalt CD-ROM-lt, vaadake sektsiooni “Using Nokia 9210 
Communicator” lõiku “PC Suite Guide”.
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Käed-vabad autovarustus CARK109

Joonis 16

Näpunäide: Aku 
laadimisaeg on sama mis 
kiirlaadija ACP-9 puhul.

Autovarustus CARK109 pakub autos kasutamiseks mugavat käed-vabad süsteemi. 
Ühtlasi laeb autovarustus ka kommunikaatori akut. Autovarustuse peab 
paigaldama kvalifitseeritud spetsialist. 
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Joonis 17

Autovarustus koosneb autohoidikust CRM-1 (joonis 17), Käed-vabad autosarja 
ühenduskarbist HFU-2, mikrofonist HFM-8 ja välisest HF valjuhääldist HFS-12. 
Soovi korral võib autovarustusega ühendada lisatoru HSU-1, mis tagab Teile 
suurema privaatsuse ning NMT/GSM antennikomplekti AMD-2, mis parandab 
vastuvõttu ning suurendab töökindlust (viimatimainitud tarvikud tuleb osta eraldi). 

Kommunikaatori asetamine hoidikusse
1 Sulgege kommunikaatori kaas ja pöörake antenn suletud asendisse.
2 Asetage kommunikaator, ühenduspesad eespool, autohoidikusse.
3 Suruge kommunikaatorit ettevaatlikult, et ühenduspesasid mitte vigastada, 

allapoole seni, kuni lukustusmehhanism sulgub.

Autovarustuses helistamine
1 Sisestage klaviatuurilt telefoninumber või kasutage nime ja telefoninumbri 

otsingu funktsiooni.
2 Vajutage . Kui soovite eraviisiliselt vestelda, tõstke kõnetoru (kui see on 

paigaldatud).

Kõne vastuvõtmine
1 Vajutage  või, kui paigaldatud on kõnetoru, tõstke kõnetoru.
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kommunikaator sissetuleva kõne automaatselt ise vastu.

Lülitumine kõnetoru re¾iimilt handsfree ehk käed-vabad 
re¾iimile
Vajutage üks kord valiku klahvile Options (valikud) ning asetage kõnetoru 5 sekundi 
jooksul tagasi. Kui asetate kõnetoru tagasi, kuid klahvile Options (valikud) ei vajuta, 
siis kõne katkeb.

Kõne lõpetamine
Vajutage  või, kui kõnetoru on paigaldatud, asetage kõnetoru tagasi.

Süütetundlikkus
Süütetundlikkuse funktsioon võimaldab hoidikusse paigaldatud kommunikaatori 
automaatse sisselülitamise sõiduki käivitamisel ja selle väljalülitamise süüte 
väljalülitamisel. Nõnda väldite auto aku tühjendamist kommunikaatori poolt, kui 
kommunikaator kogemata pikemaks ajaks hoidikusse jääb.

Kui süütetundlikkuse andur on autosse paigaldatud, on see funktsioon kogu aeg 
kasutatav. Kui Te seda funktsiooni kasutada ei soovi, paluge see paigaldamata 
jätta.

Süüte väljalülitamisel ilmub displeile teade “Phone will power off, if not used”. Kui 
Te 15 sekundi jooksul ühelegi klahvile ei vajuta ega kommunikaatorit hoidikust ei 
tõsta, lülitub kommunikaator välja.

Autoraadio vaigistus
Kõnealune funktsioon vaigistab kõne ajaks Teie auto raadio, kui raadio seda 
võimaldab. Paluge ühendada autovarustusega ka autoraadio vaigisti.
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Võimaldab sisse lülitada auto välisantenni elektrimootori.

Autolaadija LCH-9

Joonis 18

Autolaadija LCH-9 abil saate autos lihtsalt ja mugavalt kommunikaatori akut 
laadida. Enamikel autodel saab laadijat ühendada sigaretisüütaja pessa. Ühendage 
autolaadija juhe kommunikaatori põhjal olevasse pessa.
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Peakomplekt HDC-8L

Joonis 19

Peakomplekt HDC-8L võimaldab privaatset audiofunktsiooni. Kõne vastuvõtmine 
ja lõpetamine toimub komplekti kuuluva mikrofoni sees oleva kaugjuhtimisnupu 
abil. Peakomplekt ühendatakse kommunikaatori põhjal olevasse ühenduspessa.
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Joonis 20

Vööklamber BCH-17 võimaldab kommunikaatorit mugavalt kaasas kanda, nii on 
see Teil vajaduse korral alati käepärast.

Vöökott

Joonis 21

Vöökott on kujundatud spetsiaalselt Nokia 9210 Communicatori jaoks. Küsige 
Nokia toodete edasimüüjatelt.
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Mälukaart
Postmargi suurune mälukaart pakub võimalust kommunikaatori mälumahu 
suurendamiseks. Mälukaart suurendab mälumahtu andmete ja 
tarkvaraprogrammide salvestamiseks. Teil on võimalik salvestada 
kommunikaatorisse uusi rakendusi ning mitmesuguseid faile, näiteks pildifaile, 
wav-vormingus helifaile, fakse ja dokumente. Mälukaarti võib kasutada ka 
kõikvõimalike rakenduste ja aadressraamatute salvestamiseks.

Märkus: Nokia 9210 kommunikaatori mälukaardid ei ühildu teiste Nokia 
kommunikaatoritega. Kommunikaatori Nokia 9110i mälukaarte saab 
aga peale formateerimist kommunikaatoris 9210 kasutada.
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Joonis 22

Universaalse adapterikaabli abil on Teil lihtsal moel võimalik ühendada oma Nokia 
9210 Communicator arvutiga. Ühendage kaabel ühilduva arvuti RS-232 
järjestikporti. Kaablit saab kasutada ka laualaadija DCH-10 ühendamiseks.


